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Program License Agreement

The information in this document is subject to change without notice and shall not be construed
as a commitment on the part of Connect One.

Connect One assumes no liability for any errors that may appear in this document.

The software described in this document is furnished under a license agreement and may be
used or copied only in accordance with the terms of such a license agreement. It is forbidden by
law to copy the software on any medium except as specifically allowed in the license agreement.
No part of this document may be reproduced or transmitted in any form or by any means,
electronic or mechanical, including but not limited to photocopying, recording, transmitting via
fax and/or modem devices, scanning, and/or information storage and retrieval systems for any
purpose without the express written consent of Connect One.

iChip, AT+i, and Connect One are trademarks of Connect One Ltd.

Copyright © 2000-2008 Connect One Ltd. All rights reserved.
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Warranty Statement

Connect One warrants to the Customer that the Products to be delivered hereunder will function
in accordance with the specifications published with regard thereto by Connect One, under
conditions of normal use and service and when used in accordance with Connect One’s
instructions, for a period of 12 (twelve) months from shipment by Connect One or its distributor
to the customer. Connect One will, at its option, repair or replace Products that fail to perform as
aforesaid. The Customer will ship defective Products to be repaired or replaced to Connect One
under warranty at Connect One’s expense, and Connect One will, at its expense, ship the
repaired Products or its replacement to the Customer.

In no event will Connect One’s liability under the foregoing warranty exceed the purchase price
of the defective Products.

The warranty set forth above will not apply (i) with respect to defects or damage caused by the
use of unauthorized parts, the making of unauthorized repairs or improper use or maintenance,
(ii) if service or repairs of the allegedly defective Products have been performed by persons other
than qualified persons who have been properly trained to perform the same, (iii) if the allegedly
defective Products have been affected by alterations, modifications or other tampering or
misuse, (iv) if the allegedly defective Products have been removed from their original packaging
prior to sale to the end-user or (v) if the allegedly defective Products have been used otherwise
than in accordance with Connect One’s instructions.

The provisions of the above sections set forth the Customer’s sole and exclusive remedies with
regard to Product failure. CONNECT ONE MAKES NO OTHER WARRANTIES, EXPRESSED OR
IMPLIED, WITH RESPECT TO THE PRODUCTS, INCLUDING BUT NOT LIMITED TO ANY WARRANTY
OF MERCHANTABILITY, FITNESS FOR A PARTICULAR PURPOSE, OR NON-INFRINGEMENT OF
PATENT OR OTHER INTELLECTUAL PROPERTY RIGHTS. THERE ARE NO OTHER WARRANTIES
WITH RESPECT TO THE PRODUCTS ARISING FROM ANY COURSE OF DEALING, USAGE OR
TRADE OR OTHERWISE. IN NO EVENT WILL CONNECT ONE BE LIABLE FOR INDIRECT, SPECIAL
OR CONSEQUENTIAL DAMAGES WHETHER UNDER THIS AGREEMENT, IN TORT OR OTHERWISE,
OR FOR AN AMOUNT IN EXCESS OF THE ACTUAL AMOUNT PAID BY THE CUSTOMER TO
CONNECT ONE FOR THE FAILED PRODUCTS.
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1 Product Overview

Connect One’s II-EVB-600 with its iChip™ CO2064SEC IP-enables and offloads connectivity tasks
from a host processor or host device. II-EVB-600 supports effortless integration of many upper
layer Internet protocols using either AT+i commands or the iChipConfig Utility, both of which are
discussed in this document.

II-EVB-600 features include the ability to stream data over TCP or UDP sockets (up to 10
simultaneous active sockets are available) and manage two listening sockets. In addition, a
secure socket (SSL3/TLS1) is fully supported. Additional features include the ability to send
plain-text e-mails; an FTP client, and the SerialNET (Device Server) mode, a plug-and-play
operating mode that enables the connection of any device with an RS232 interface to the
Internet, without changing anything on the device’s hardware or software.

1.1 iChip 2064SEC: The II-EVB-600 Internet Engine

The host processor communicates with the II-EVB-600 via Connect One’s high-level AT+i™
command set. AT+i commands are simple ASCII characters that are sent across the RS232
interface. The AT+i Application Programming Interface (API) requires writing just a few lines of
code on the host processor to implement Internet connectivity.

AT+i commands make it very easy to configure, test, and implement high-level Internet
protocols with virtually no understanding of TCP/IP or other Internet protocols. Thanks to the
AT+i commands, the device only needs to tell the II-EVB-600 what task to perform, but not how
to perform it. For example, if the device has to send textual e-mail, after a one-time short
configuration of subject, recipient, mail account, etc., the device sends AT+IiEOA:<l/ines of text>.

The iChip inside the II-EVB-600 establishes a connection or uses the existing one, builds the
e-mail (headers and content), connects to the SMTP server, and sends the e-mail. A status
report is sent to the device upon completion. All these actions are completely hidden from the
device and only require sending a few characters in addition to the e-mail content. This mode of
operation is applicable for all features of the II-EVB-600.

1.2 How to Use this Manual

iChipConfig Utility is a front-end Windows-based user interface for the AT+i commands. The
iChipConfig Utility, combined with the II-EVB-600, enables quick and full product configuration,
serial-based updating of firmware, and packaging of a parameters file. This functionality is
achieved from any device, machine, or system.

Note: From this point onward, this manual assumes that you have the iChipConfig Utility
installed. The configuration, running and testing of the II-EVB-600 is demonstrated via the
iChipConfig Utility, although they can also be carried out using AT+i commands. For a complete
description of the AT+i interface and commands, please refer to the AT+i Programmer's Manual
on the Connect One website: http://www.connectone.com.

To set up the iChipConfig Utility, please refer to the iChipConfig Utility User Manual Version
2.4.44 or higher.

The latest version of the iChipConfig Utility can be found on the Connect One website:
http://www.connectone.com.

Product Overview 1
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2 Getting Started

This section describes the content of the II-EVB-600 package, provides additional relevant
documentation to enhance and fine-tune the II-EVB-600 functionality, and includes unpacking
and first-time configuration instructions. The final section of this chapter offers several ways to
test the II-EVB-600 LAN connection.

2.1 What’s in the Package?

The II-EVB-600 is a turnkey boxed solution and, as such, is supplied with all necessary
accessories. The package includes the following items:

e II-EVB-600 evaluation board
e RS232 cable

e RJ45 Cat 5 100BaseT cable
e 110V or 220V power supply
e Extra iChip CO2064SEC

2.2 Additional Documentation

The II-EVB-600 is built around the iChip CO2064SEC. Great flexibility in configuration and
operation of this product can be achieved via proper use of the AT+i commands.

For the sake of simplicity, the II-EVB-600 configuration and operation is described in this
document mainly through the iChipConfig Utility.

The iChipConfig Utility and the iChipConfig Utility User Manual can be downloaded from the
Connect One website.

Note: Because documentation, utilities and firmware files change from time to time, please be
sure to check for the latest version on the Connect One website: http://www.connectone.com.

2.3 Unpacking and Installing
The II-EVB-600 installation is simple and all the required accessories are supplied with the
device.

The II-EVB-600 is provided pre-configured to work with LAN using COM1 on the
II-EVB-600 as host interface. For additional configuration options, see section 2.5 Jumper
Settings.

> To install the II-EVB-600 and connect it to a LAN network:

1 Connect the RJ45 cable to the II-EVB-600 RJ45 port. Connect the other end of
the cable to a 10/100BaseT or 100BaseT Ethernet switch or hub.

Getting Started 2
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2 Connect one side of the RS232 cable to the II-EVB-600 RS232 COM1 port and
the other side to your device or PC’s COM port.

3 Connect the power supply to the DC jack on the II-EVB-600 and apply power.

The Link LED (orange) on the R3J45 should now be on and the Activity LED
(green) should blink occasionally, reflecting network traffic.

To test the connection, use AT+i commands or the iChip Config Utility to invoke any of the
activities that trigger the iChip to go online and use the Internet or local LAN.

Getting Started 3
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2.4 Connectors and Switch Positions
241 Connectors
Name Type Function

1 J2A HEADER 17X2 C02128 EXTENSION
2 J2B HEADER 13X2 C02128 EXTENSION
3 j2Cc HEADER 17X2 C02128 EXTENSION
4 J2D HEADER 13X2 C02128 EXTENSION
5 J1 HEADER 20X2 EBI BUS (for CO2128)
6 J2 HEADER 20X2 EBI BUS (for CO2128)
7 J4 HEADER 10X2 HPI (for CO2128)
8 J5 DB9 - FEMALE COMO (for CO2128)
9 J6 HEADER 5X2 SSC (for CO2128)
10 J7 RJ11 Telephone Line (from Uartl)
11 J8 DB9 -MALE COM1
12 J9 RJ45 10/100BaseT
13 J10 HEADER 4X1 TWI
14 J11 SIM CARD SIM CARD
15 J12 HEADER 6X1 SPI1
13 J13 HEADER 6X1 SPIO
14 J14 DB9 - FEMALE COM2
15 J15 USB-A USB Host
16 Ji6 DC-JACK POWER Supply
17 J17 USB-B USB Device
18 J18 BLOCK 2 Pin Analog Input
19 J19 HEADER 8X2 MII EXTENSION
20 J20 HEADER 5X2 MII EXTENSION

Getting Started
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2.4.2 Switches

Name Type Function
1 SW1 PUSH BOTTOM MSEL
2 SwW2 PUSH BOTTOM RESET
3 SW3 TOGGLE SWITCH POWER On/Off

2.5 LED Positions

Name Type Function
1 D1 G.LED RXDO
2 D2 G.LED TXDO
3 D3 G.LED DTR1
4 D4 G.LED CD1
5 D5 G.LED RXD1
6 D6 G.LED TXD1
7 D7 G.LED RXD2
8 D8 G.LED TXD2
9 D9 R.LED iChip Error
10 | D13 G.LED FW_RDY
11 | D14 R.LED 3V vDDIO
12 | D17 G.LED DATA READY
13 | D19 R.LED 5V For USB Host
14 | D20 R.LED 1.2V

Getting Started

Downloaded from Elcodis.com electronic components distributor


http://elcodis.com/

II-EVB-600 User Manual Getting Started

2.6 Jumper Settings

Name Setting

1 JpP2 1-2 ONREG Pin=0 working with external VDD core ; 2-3 ONREG
Pin=1 working with internal VDD core

2 JP3 ON -External VDDCore (For CO2064)

3 JP5 ON -External VDDCore (For CO2128)

4 JP6 ON- Enable 1K Pull-up Resistor On HPI_nWAIT signal.
(HPI_Wait_Enable For CO2128)

5 JP7 ON- Enable COMO (only when HPI is disable) (For CO2128)

6 JP8 ON - Power to J6 Connector (SSC) (For CO2128)

7 JP9 ON- Enable HPI (For CO2128)

8 JP10 ON- Enable Socket Modem (on Uartl)

9 JP11 ON- Enable COM1

10 | JP12 ON - Power to J10 Connector (TWI)

11 | JP13 ON- Enable 1K Pull-up Resistor On TWI_TWD signal.

12 | JP14 ON- Enable 1K Pull-up Resistor On TWI_TWCK signal.

13 | JP15 ON- Enable SIM CARD

14 | JP16 ON- SIM Card 3V ; OFF SIM Card 5V

15 | JP17 ON- Enable SIM Card Interrupt .

16 | JP18 ON - Power to J12 Connector (SPI1)

17 | JP19 ON - Power to J13 Connector (SPIO)

18 | JP20 ON - Enable SPI1 Flash

19 | Jp21 1-2 = COMO+ssc ; 2-3 = HPI

20 | JP22 1-2 = MII ; 2-3 = RMII+COM1

21 | JP23 1-2 =S.C ; 2-3 =SPIO

22 | JP24 1-2 = SPI1; 2-3 =TWI

23 | JP25 1-2 = LAN_EN ; 2-3 = LAN_DIS;

24 | JP26 1-2 = BYPASS Rom ;2-3 = ENGAGE Rom

Getting Started 6
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25 | IP27 1-2 = UHP_EN ; 2-3 = UHP_DIS
26 | JP28 ON - COM2 Enable COM2_EN
27 | JP29 ON - Enable Parallel Flash (For CO2128)

2.7 Bill of Materials

Part Description Designation | Quantity
Electromagnetic Sound Transducer/RoHS LS1 1
Capacitor 1nF/3KV, Size 7mm C53-C54 2
Capacitor 1uF/16V, TANTALOM, Case A C107 1
Capacitor 1uF/16V, TANTALOM, Case A C80 1
Capacitor 1uF/16V, TANTALOM, Case A C109 1
Capacitor 1uF/16V, TANTALOM, Case A C35-C36 2
Capacitor 1uF/16V, TANTALOM, Case A C39 1
Capacitor 10uF/16V,TANTALOM,Case B/RoHS C88 1
Capacitor 10uF/16V,TANTALOM,Case B/RoHS C108 1
Capacitor 10uF/16V, TANTALOM,Case B/RoHS C42 1
Capacitor 10uF/16V, TANTALOM,Case B/RoHS C56 1
Capacitor 10uF/16V, TANTALOM,Case B/RoHS C58 1
Capacitor 10uF/16V,TANTALOM,Case B/RoHS C20 1
Capacitor 10uF/16V,TANTALOM,Case B/RoHS Cc79 1
Capacitor 10uF/16V, TANTALOM,Case B/RoHS C113 1
Capacitor 10uF/16V,TANTALOM,Case B/RoHS C92 1
Capacitor 15pF C100-C101 | 2
Capacitor 22pF C33-C34 2
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Capacitor 47pF C104 1
Capacitor 47pF C94-C95 2
Capacitor 100nF, Size 0603 C71-C78 8
Capacitor 100nF, Size 0603 C81-C82 2
Capacitor 100nF, Size 0603 C86 1
Capacitor 100nF, Size 0603 C90-C91 2
Capacitor 100nF, Size 0603 C98-C99 2
Capacitor 100nF, Size 0603 C18 1
Capacitor 100nF, Size 0603 C110-C112 | 3
Capacitor 100nF, Size 0603 C22-C32 11
Capacitor 100nF, Size 0603 C37 1
Capacitor 100nF, Size 0603 C41 1
Capacitor 100nF, Size 0603 C43-C44 2
Capacitor 100nF, Size 0603 C49-C52 4
Capacitor 100nF, Size 0603 C55 1
Capacitor 100nF, Size 0603 C57 1
Capacitor 100nF, Size 0603 C59-C60 2
Capacitor 100nF, Size 0603 C102-C103 | 2
Capacitor 100nF, Size 0603 C65-C68 4
Capacitor 100nF, Size 0603 C105-C106 | 2
Capacitor 100uF/10V TANTALOM Case D C69-C70 2
Capacitor 470nF Co3 1
Capacitor 470nF C61-C64 4
Capacitor 470nF c87 1
Capacitor 470nF C45-C48 4
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Capacitor 470nF C83-C85 3
Capacitor 1000uF/25V Electrolytic/RoHS C96-C97 2
iChipSec C0O2128, 128pin LQFP, 3.3v, 48MHz, RoHS | U1B 1
D-Sub Right Angle, Female 9 pin Connector/RoHS J5 1
D-Sub Right Angle, Female 9 pin Connector/RoHS J14 1
D-Sub Right Angle, Male 9 pin Connector/RoHS J8 1
Connector DC-JACK 2.1mm/RoHS Ji6 1
ABS UL94-V0; 0.46m/m DIA J7 1
RJ45 10/100BaseT Magnetics/RoHS J9 1
CON SIM/SMA Holder/RoHS J11 1
CONN TERMINAL BLOCK 2POS 5mm PCB/RoHS j18 1
CONN USB FEMALE TYPE A PCB J15 1
CONN USB FEMALE TYPE B PCB J17 1
Crystal Clock 12 MHz/RoHS Y2 1
1.0 AMP SILICON RECTIFIERS DIODE/RoHS D10 1
DIA SURGE SUPPRESSOR (DSS) RV1 1
FAST SWITCHING SURFACE MOUNT DIODE/RoHS D15-D16 2
FAST SWITCHING SURFACE MOUNT DIODE/RoHS D12 1
Ultrafast Rectifiers 1.0A ;50V-600V/RoHS D11 1
Header 2mm Pitch SQ Tail Socket

2pin,Female/RoHS USA 1
HEADER 2x1 / MALE 100 MIL PITCH J20 1
HEADER 2x1 / MALE 100 MIL PITCH JP5-1P7 3
HEADER 2x1 / MALE 100 MIL PITCH JP13-JP17 5
HEADER 2x1 / MALE 100 MIL PITCH JP9-Ip11 3
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HEADER 2x1 / MALE 100 MIL PITCH JP28-1P29
HEADER 3x1 / MALE 100 MIL PITCH P2
HEADER 3x1 / MALE 100 MIL PITCH JP21-1P27
Header 2mm Pitch SQ Tail Socket

4pin,Female/RoHS usbD
HEADER 4x1 / MALE 100 MIL PITCH J10
HEADER 5x2 / MALE 100 MIL PITCH J20
HEADER 5x2 / MALE 100 MIL PITCH J6
HEADER 6x1 / MALE 100 MIL PITCH J12
HEADER 8x2 / MALE 100 MIL PITCH J19
Header 2mm Pitch SQ Tail Socket

9pin,Female/RoHS U8B-US8c
HEADER 10x2 /MALE 100 MIL PITCH J4
HEADER 20x2/FEMALE100 MIL PITCH/RoHS J1-32
Low Power High Speed Rail to Rail Amp/RoHS uz23

Low Power High Speed Rail to Rail Amp/RoHS uz26

Low Voltage Audio Power Amplifier/RoHS uo

SDPT Analog Switch/RoHS u22

1A Step-Down Regulator;Out-3.3v/RoHS uz21

8 MBIT,Buttom-Boot 3v Flash/RoHS u2
4Mbit 3.3V Serial Flash with SPI Interface/RoHS ulieé

IC Buffer/Ldriver Octal/RoHS u7z

IC Buffer/Ldriver Octal/RoHS uis

IC Buffer/Ldriver Octal/RoHS uiz
Octal Buffers/Drivers With 3-State Outputs u1o0
Octal Buffers/Drivers With 3-State Outputs ué
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3V Octal Bidirectional Transceiver/RoHS us 1
IC SINGLE INVERTER GATE / RoHS u3 1
10/100 PHY CONTROLLER/RoOHS ui4 1
100mA Low-Drop Regulator 1.2v/RoHS uz20 1
Adjustable 1.5A LDO Voltage Regulator ui1l9 1
RS232, 3 Driver/5 Receiver 3v/5v,Ind/RoHS u4 1
RS232, 3 Driver/5 Receiver 3v/5v,Ind/RoHS uiz 1
RS232, 3 Driver/5 Receiver 3v/5v,Ind/RoHS Uil 1
3v/3.3v Micro Supervisory Circuit, Ind/RoHS u24 1
Smart Card Interface/RoHS u1s 1
Temp Sence/RoHS uz27 1
Indactor Unshiled 68uH 1.1A SMT/RoHS L4 1
BK2125-102/RoHS L2 1
BK2125-102/RoHS L9-L12 4
Wound Beads,Turns:2x1.5; Wire:0.53 24

AWG/RoHS L1 1
2mm Plastic Female Jumper 2pin/RoHS JpP2 1
2mm Plastic Female Jumper 2pin/RoHS JP5-]P7 3
2mm Plastic Female Jumper 2pin/RoHS JP13-Ipl17 5
2mm Plastic Female Jumper 2pin/RoHS JP9-JP11 3
2mm Plastic Female Jumper 2pin/RoHS JP20-JP29 10
LED-GREEN 3mm D17 1
LED-GREEN 3mm D1-D8 8
LED-GREEN 3mm D14 1
LED-RED 3mm D13 1
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LED-RED 3mm D19-D20
Oscillator Clock 50MHz, SMD,Ind/RoHS ul3
POLYSWITCH RXE Series 0.30A Hold/RoHS F1
Potentiometer 10K Ohm / RohS P1
Resistor 0 Ohm 10% R87
Resistor 0 Ohm 10% R85
Resistor 0 Ohm 10% R149
Resistor 0 Ohm 10% R94
Resistor 0 Ohm 10% R136
Resistor 0 Ohm 10% R50
Resistor 2 Ohm 10% R68-R69
Resistor 3K R135
Resistor 3K R106-R112
Resistor 3K R117
Resistor 4.7K 10% R131
Resistor 6.8K 1% R86
Resistor 10 Ohm 10% R70
Resistor 10K 1% R65
Resistor 10K 1% R90-R93
Resistor 10K 1% R62
Resistor 10K 1% R78-R80
Resistor 10K 1% R145-R146
Resistor 15k R122
Resistor 15k R126
Resistor 15k R120
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Resistor 27 Ohm 10% R119 1
Resistor 27 Ohm 10% R121 1
Resistor 27 Ohm 10% R123-R124 | 2
Resistor 33 Ohm 10% R7-R48 42
Resistor 49.9 Ohm 1% R81-R84 4
Resistor 100 Ohm 10% R116 1
Resistor 100K 10% R63 1
Resistor 100K 10% R98 1
Resistor 100K 10% R53-R61 9
Resistor 100K 10% R71-R73 3
Resistor 100K 10% R115 1
Resistor 100K 10% R51 1
Resistor 300 Ohm 10% R118 1
Resistor 470 Ohm 10% R128 1
Resistor 470 Ohm 10% R88-R89 2
Resistor 470 Ohm 10% R130 1
Resistor 470 Ohm 10% R134 1
Resistor 470 Ohm 10% R143 1
Resistor 470 Ohm 10% R66-R67 2
Resistor 470 Ohm 10% R113-R114 | 2
Resistor 470 Ohm 10% R147 1
Resistor 470 Ohm 10% R74-R77 4
TOGEL SW ON/OFF-SPDT-90D/RoHS SW3 1
SW-TACK/RoHS SW1-Sw2 2
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2.9 Running the iChipConfig Utility for the First Time

This section describes how to start running the iChipConfig Utility.
To start the iChipConfig Utility:

1. Select Programs > ConnectOne > iChipConfig from Windows Start menu. The iChip
Configuration Tools window is displayed:

=¥ iChip Configuration tools
File Tools ‘Wizards Host<-=iChip options 3Serial Ports SerialhET  Options  Help

Click on the desired operation icon

Quick Configuration Site Pack Send Email Script Tool
attachment
@ b
.
- . iChip site Uploader Receive Email Change iChip
Full Configuration via HTTP plus platform

——y Dpoo

Wi = =

iChip Uploader Dumb Terminal Get URL Exit
via gerial
1101 0010
1011 0001
01101111
0111 0010
|
Fieady Port: COR1 Baud Rate: 115200

2. Select the desired operation by clicking the appropriate icon.

When an icon is selected (except Exit), the iChipConfig utility attempts to locate the
II-EVB-600 on one of the PC’s COM ports at the default baud rate of 38400.

If the II-EVB-600 is not located, the Serial Settings dialog box is displayed:
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Serial Settings

Serial Port Baud Rate

COM1 | |115200 ~|
4800

iChip was nat found. ?gggu

Another program may be usi

Please select a port and pre 38400

again. 57600
115200

Press Cancel to skip seaIChZSBODU

1]

Cancel 0K

This dialog box is also displayed if you select Serial Ports from the menu bar.
3. From the Serial Port drop-down list, select the port to which the II-EVB-600 is attached.
4. In the Baud Rate area:
= Select the exact Baud Rate used by the II-EVB-600.
-or-
= Select Scan if you don’t know the baud rate.

If Scan is selected, iChipConfig Utility runs through the different baud rates until the correct
baud rate to be used is found. The following message is displayed:

x

iChip found, Port: 1 Baud rate: 115200

Note: If iChipConfig Utility still fails to find the II-EVB-600, make sure that there are no
applications open, such as Palm HotSync, occupying the port; switch to a different COM port and
try Scan again. After iChipConfig has found the baud rate, you can easily change it by opening
the Serial Settings dialog box and selecting the desired baud rate.

2.10 Configuring for Connection

To be part of the LAN, the II-EVB-600 needs basic LAN settings, such as IP Address, Subnet and
Gateway IP address. There are two ways to configure this set of parameters for II-EVB-600:

= Dynamic IP Allocation (Via DHCP)

= Fixed IP Configuration (Via User Assignment)
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2.10.1  Dynamic IP Allocation

By default, the II-EVB-600 is configured to gain LAN access via DHCP. Therefore, if a DHCP
server is present, there is no need for additional configuration.

Specific configuration for acquiring LAN settings via DHCP can be carried out from the Quick
Configuration window in the figure below:

=* jChip LAN Quick configuration

File

Aszszigned IP address [IPA) MAC Address

| | I

IP Address [DIP) Sub Net

[~ Use DHCP Gateway

[~ Use IP Finder o Jo Jo Jo

SMTP Server

Destination email address

Return email address

Optional
DNS51 Server DN52 Server
b o ol ol
iChip type :  CO2064- L iChip LA Firmware wer :  [L720B03 11,10 2007 (&)
Serial num : 11002233 Boot block :
Close
|
Ready Part: COM1 Baud Rate: 115200

1. Select the Use DHCP check box and click Save.
2. To activate these settings, recycle power to the II-EVB-600.

Note: II-EVB-600 supports DHCP Server extensions. This means that if your server’s assignees’
have additional LAN settings, such as SMTP server, the II-EVB-600 automatically configures and
uses these settings.

2.10.2 Fixed IP Configuration

To configure the II-EVB-600 to work with a fixed IP address, the following parameters should be
configured:

1. Use the Quick Configuration screen to set the following parameters:
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2.

IP Address (DIP): Set it to the IP address you want the II-EVB-600 to have.
Subnet (SNET)

IP Gateway (IPG)

Click Save and recycle power to the II-EVB-600.

These settings can also be configured using the following AT+i commands:

AT+iDIP
AT+iSNET
AT+IIPG

A detailed description of these commands can be found in the AT+i Programmer's Manual.
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3 Firmware and Parameters Update

This section describes the II-EVB-600 local firmware and parameters update capabilities using
the iChipConfig utility.

It also describes how to create and use parameter files (*.RPF).

3.1 Local Firmware Update

The II-EVB-600 can be updated locally in one of two ways. You can upload the firmware directly
from the host (PC, in our case) via the RS232 interface, or from the external flash memory
provided on the II-EVB-600 via the SPI interface.

3.1.1 Loading the Firmware from Host

To load the iChip firmware from host memory via the RS232 serial interface, you need to obtain
the RAM version of the firmware flavor you wish to install from Connect One. The RAM version is
provided as two separate files: a version.hdr file and a version.dat file. The following procedure
assumes that you have a host application running on your PC, in which you insert appropriate
lines of code, as detailed below.

1. Power up the II-EVB-600 and assert the MSEL pin for at least 5 seconds.

2. Use the connected UART at a baud rate between 9600 and 115200 to send a capital U
character to the iChip. Wait for a > prompt.

Send a capital L and wait for a > prompt.
Send the version.hdr file and wait for a > prompt.

Send the version.dat file.

o v AW

The firmware is now loaded into iChip’s RAM and ready for use.

3.1.2 Loading the Firmware from SPI Flash Memory
1. Invoke the iChipConfig utility.
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? iChip Configuration tools Q@@

File Tools Wizards Host<-=>iChip options Serial Ports SerialNET Options Help

Connect’

Click on the desired operation icon

Quick Configure Site Pack Send Email Script Tool
attachment
80
B —
5 = iChip site Uploader Receive Email Change iChip
Full Configuration via HTTP plus platform
=== El=I=]

Wl =y =

iChip Uploader Dumb Terminal Get URL Exit
via serial

1101 0010

1011 0001 == @

01101111 25

0111 0010

Ready | Port: COM1 Baud Rate: 115200

2. Click Tools > C02128/2064 Monitor Mode.
3. In the dialog box displayed, select the SPI Flash 4 Mbit check box and click OK.

Choose Flash Type

Flash Types

" EBI Flash 8 Megabit [512 K x1E-bit] bottom
" EBI Flash B4 Megabit (4 M » 16-bit)

114 | Cancel

4. Wait for the utility to finish loading FPRO into iChip’s RAM.

] [Laading FFRO ta iChip...

Time Elapsed:  00:00:01

Cancel

5. Power up the II-EVB-600 while holding down the MSEL switch for at least 5 seconds and OK
the dialog box.
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iChipConfig

Please recycle power to iChip while holding the Mode Select switch For at least 5 seconds,
Click OF ko continue or Cancel ko cancel operation.

Cancel |

General Settings

[~ Send Ascii

B aud rate | 115200 j

Scan

DOperations

Get Info
Fw Update
Memory Dump
Dump Memory to file

Ezit Monitor mode

7. In the dialog box that appears, select the .imf image file of the firmware you wish to upload

and click Open.
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Look ir: |L§ Lan j EF '

[Eizos4i721001bspissLimf [ iz0641720003aRam. dat
4 [ izne4i721d01aRam dat [ iz064i720b03R am. hdr
My Fiecent i20641721d01aRam hdr 206417 20B03aR am.imf
Desumiests 20641721001 aRam.imf f i
@ 20641721001 aSpi.imf
i6i611720b03 i
Desktop i1 101720003 imf
. 112017206034, imf
U i120w7206034, imf
i20641720B03bSpiSSL.imf
i20641720b03bRamS5L dat
i20641720b03bRamS5L hdr

P_‘J)‘g i20641720803bRam35L.imf

My Computer <

My Documents

2
i File name: |i2DB4I?2DBDSaS pi.imf j Open |
My Metwark  Files of bpe: |AII files(".") j Cancel
Places

™ Open a: read-only

8. Click Yes when prompted.

iChipConfig

Are you sure you want ko send File 11172,20,0,113DeviImodem’imfiL an\ 20647 20B03a5pi.imf?

9. The following screen appears:

0 Tl [twiiting to address 10021800 0+400 words

Time Elapzed 00:00:02 Total Size: 0x6C348

Cancel

10. Click OK on the Image file loaded successfully dialog box.

iChipConfig

Image file loaded successfully

The firmware is loaded into the SPI flash memory. When you reset the iChip, it automatically
loads the firmware from flash memory into its internal RAM.

3.2 Managing Parameter Files

Parameters for the II-EVB-600 are stored in *.RPF files. Parameter files can be used to save
current configurations to be loaded for later use or to automate product distribution.
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3.21 Saving the II-EVB-600 Configuration to an RPF File

The parameters stored in the II-EVB-600 can be saved to a Remote Parameter File (RPF) or
loaded from an RPF file onto the II-EVB-600.

To save the current configuration to an RPF file:

1. Click the Full Configuration icon. The II-EVB-600 Full Configuration window is
displayed.

2. Click File > Save as RPF File in the Full Configuration window. The RPF Parameters
dialog box is displayed:

RPF parameters

Include these parameters in RPF file
[~ Start from factory defaults

[~ Group

[~ Destination Chip Serial number

Cancel |

3. Configure the following parameters and click OK:

= Select the Start from factory defaults check box if you want to save the factory
default settings as your new parameters.

= Do not select the Start from factory defaults check box if you want to save your
current configuration (except for parameters) in the RPF file.

= Group - Not relevant

= Destination Chip Serial Number - Not relevant

3.2.2 Loading an RPF File
To load an RPF file onto the iChip:

1. Select File > Load RPF file from the iChipConfig menu. The Open dialog box is
displayed:
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Look in: I m Desktop

<
£

History

i Idocs ta review

i iChip config

| iChip_and_PICDEM-2_Demo
[:l images

] temp iChip config

My Documents [ﬁ,Shortcut to Connectl

o

\i

My Computer

File hame: F'x'ﬁ.F: FREE1 3 | Open I
:J Cancel I

Files of type: | RPF Files(*.RPF)
I Dpen as read-only

4

2. Browse to the appropriate RPF file and click Open. All the parameters from the RPF file
are loaded onto the II-EVB-600.

3. If anillegal parameter value has been assigned, iChipConfig Utility displays the illegal
parameter and offers to save it to a log file. Enter a new valid parameter value and
Load/Save the RPF file again.
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